Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

**CAUTION**
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

**NOTICE**
indicates that an unintended result or situation can occur if the corresponding information is not taken into account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes in this documentation qualified persons are defined as persons who are authorized to commission, ground and label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Note the following:

**WARNING**
This device may only be used for the applications described in the catalog or the technical description and only in connection with devices or components from other manufacturers which have been approved or recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage, positioning and assembly as well as careful operation and maintenance.

Trademarks

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1 Definitions and warnings....................................................................................................................... 5

2 Hardware Requirements............................................................................................................................ 7

2.1 Converter .......................................................................................................................................7

3 Software Requirements ............................................................................................................................. 9

3.1 Converter .......................................................................................................................................9

3.1.1 Software Requirements .................................................................................................................9

3.1.2 Upgrading the software................................................................................................................10

4 Commissioning ........................................................................................................................................ 13

4.1 Commissioning procedure .............................................................................................................13

4.2 Table of the settings .........................................................................................................................14

4.3 Creating a STEP 7 project ..............................................................................................................15

4.3.1 Configuring the hardware ............................................................................................................15

4.3.2 Creating an axis ..........................................................................................................................26

4.3.3 Referencing ..................................................................................................................................43

4.3.4 "Measuring" function .....................................................................................................................57

4.3.5 Activating a brake ........................................................................................................................64

4.3.5.1 Vertical axis application case .......................................................................................................64

4.3.5.2 Activating braking sequential control in the axis ..........................................................................65

4.3.5.3 Activating the braking control in the MASTERDRIVE MC ...........................................................70

4.4 Basic commissioning of MASTERDRIVES MC ...............................................................................72

4.5 Connect MASTERDRIVES MC to the Technology-CPU ...........................................................77

5 MASTERDRIVES MC commissioning tool...........................................................................................87
Definitions and warnings

Qualified personnel

Commissioning and operation of the devices are to be carried out by qualified personnel only.

"Qualified personnel" means those who are familiar with the installation, mounting, commissioning, operation and maintenance of the SIMOVERT MASTERDRIVES product. Then they must have the following appropriate qualifications:

- Trained and authorized to energize, de-energize, clear, ground and tag circuits and equipment in accordance with established safety procedures.
- Trained in the proper care and use of protective equipment in accordance with established safety procedures.
- First aid training.

Warnings are not explicitly given in this documentation. However, you are strongly advised to note the warnings contained in the Operating Instructions for each product from the MASTERDRIVES series.

The script file to connect SIMOVERT MASTERDRIVES Motion Control to SIMATIC with the standard telegram frame 5 is available at no cost. It may be copied, modified and used or passed on to third-parties. However, in the case of it being passed on to a third party, it must be in its full and unmodified form, and all copyright conditions must be observed. The commercial distribution to a third party (for example in share/freeware distribution) is only permitted with the previous written agreement of the Siemens AG.

As you have been given the script file for linking the SIMOVERT MASTERDRIVES Motion Control to the SIMATIC with standard message frame 5 at no cost, the authors and rights holders accept no liability for it. You use this file at your own risk and responsibility. The authors and rights holders may only be held liable for criminal intent and gross negligence. No further claims shall be accepted. In particular, the authors and rights holders shall not be held liable for any defects or consequential losses.

Should you come across errors in the script file, please inform us.
Hardware Requirements

2.1 Converter

Motion Control Compact PLUS
- none

Motion Control
- Derating has to be taken into account for compact devices from 75kW (refer to MASTERDRIVES Motion Control Catalog DA 65.11).

This means that if devices are operated with a pulse frequency greater than 5kHz, the permissible rated current is reduced and the device can no longer be operated at its rated power.

PROFIBUS communication module (CBP2)
- A CBP2 must be installed.

Whether the converter has a CBP2 or not, can be identified in the monitoring parameter r826.x. If the monitoring parameter is not displayed, then initially, the basic unit should be commissioned as described in Chapter "Basic commissioning MASTERDRIVES MC".

The index x designates the slot in which the CBP2 is plugged in. (Index 1 means the basic device module, Index 2 the module in slot A etc.; additional information can be found in the Motion Control Compendium in the parameter list)

If it involves a CBP2, then a value of 148 is output; if it involves a CBP1, then a value of 143 is output.
Hardware Requirements

2.1 Converter
Software Requirements

3.1 Converter

3.1.1 Software Requirements

Motion Control/Motion Control Compact PLUS

- Version V1.60 or later; can be identified in r69.1 and r828.1.
  
  If the monitoring parameter is not displayed, then initially, the basic unit should be commissioned as described in Chapter "Basic commissioning MASTERDRIVES MC".

  A description of how to upgrade the converter firmware is provided in the Motion Control compendium (Section 7.4 in the AC Edition)

PROFIBUS communication module (CBP2)

- Version V2.23 or higher; can be identified in r69.x and r828.x.

  If the monitoring parameter is not displayed, then initially, the basic unit should be commissioned as described in Chapter "Basic commissioning MASTERDRIVES MC".

  The index x designates the slot at which the CBP2 is plugged in. (Index 1 means the basic device module, Index 2 the module in slot A etc.; additional information can be found in the Motion Control Compendium in the parameter list)

  It is only possible to upgrade the option card firmware using Drive Monitor or Drive ES.

  A bootstrap file (e.g. CBP2_DL.hex) and a program file (CBP2_V223.hex) of Version 2.23 or higher is required for this purpose.

  The procedure is described in the following.
3.1.2 Upgrading the software

Procedure

1. The Drive Monitor or Drive ES may only access the converter RAM for upgrading the firmware.

![Figure 3-1 Drive Monitor accesses the RAM of the MC](image1)

2. Open the window for the option card download:

![Figure 3-2 Opening the Option Card Download window](image2)
3. Enter the path for the bootstrap file, the program file and the slot in which the CBP2 is installed. Activate the Activate diagnostics checkbox.

**Note**

You can download the current firmware version from the Internet:

[http://support.automation.siemens.com](http://support.automation.siemens.com)

Entry ID 10999663

![Figure 3-3 Settings in the Option Card Download window](image)

4. Right-click a free area of the screen.
   The following window opens:

![Figure 3-4 Additional settings for the download](image)

5. Enter a program length of 128KB and 8 EEPROM blocks.
Software Requirements

3.1 Converter

6. Activate the **Check** button. This then changes into **Start Download**. Click on this button. The EEPROM blocks are deleted. The following window opens:

![Start of the script file download](image)

Figure 3-5 Start of the script file download

7. Start the download with **Start**.

Result

After the download, you can read out the new firmware release of the CBP2 from parameters r69.x and r828.x.
4.1 Commissioning procedure

Note
This Guide only describes how to set-up the connection between the SIMOVERT MASTERDRIVES Motion Control converters/inverters and the Technology-CPU. The guide does not describe how to optimize the controller; it is assumed that this has already been carried out.

Operational sequence

The commissioning procedure is divided into two parts:

In the first part, a STEP 7 project is created and the S7T Config program and the hardware manager are used to enter the settings for the Technology-CPU. Settings which have to be made both in the Technology-CPU and in the MASTERDRIVES MC are specifically highlighted.

In the second part of the commissioning, the MASTERDRIVES MC is parameterized. The guided basic unit commissioning procedure and a pre-programmed script file for connection to the Technology-CPU are used.

Various parameter settings for MASTERDRIVES MC are derived from the Technology-CPU settings. The table in Chapter 1.2 contains an overview of the functions and settings which have to be entered into the Technology-CPU and MASTERDRIVES MC. The settings made can be entered into the table. These settings are described separately for the Technology-CPU and for MASTERDRIVES MC in the following sections.
## 4.2 Table of the settings

### Settings for commissioning

You will require this data for the following commissioning steps. As preparation, you can define the values using this table.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>DP cycle</td>
<td>______ ms</td>
</tr>
<tr>
<td>Specify Encoder</td>
<td></td>
</tr>
<tr>
<td>- Incremental encoder</td>
<td></td>
</tr>
<tr>
<td>- Absolute encoder</td>
<td></td>
</tr>
<tr>
<td>Referencing mode</td>
<td></td>
</tr>
<tr>
<td>- Reference cam + encoder zero mark</td>
<td></td>
</tr>
<tr>
<td>- Only encoder zero mark</td>
<td></td>
</tr>
<tr>
<td>- Only reference cam</td>
<td></td>
</tr>
<tr>
<td>- 1. Zero position to the right of the reference cam</td>
<td></td>
</tr>
<tr>
<td>- 1. Zero position to the left of the reference cam</td>
<td></td>
</tr>
<tr>
<td>&quot;Measuring&quot; function</td>
<td></td>
</tr>
<tr>
<td>Encoder type (Order No.)</td>
<td>1Fxxxxx- _ xxxx-x _ xx</td>
</tr>
<tr>
<td>Rated motor speed/max. speed, axis</td>
<td>______ 1/min</td>
</tr>
<tr>
<td>Master application cycle/position controller</td>
<td></td>
</tr>
<tr>
<td>clock cycle</td>
<td></td>
</tr>
<tr>
<td>Telegram type (refer to the decision table)</td>
<td></td>
</tr>
<tr>
<td>PROFIBUS address</td>
<td></td>
</tr>
</tbody>
</table>
4.3 Creating a STEP 7 project

4.3.1 Configuring the hardware

Introduction

In this step, the Technology CPU, the bus system and the connected devices - in this case, MASTERDRIVE MC - are configured using the program Hardware Configuration and S7T Config in STEP 7.

Procedure

- After the SIMATIC Manager starts, you must first create a new project (under a freely selectable name).
- A new S7 300 station is created with the menu command Insert > Station > SIMATIC 300 station.
- The Hardware Configuration is opened by double-clicking on the element Hardware in the SIMATIC 300 station.

The application HW Config starts and opens the empty SIMATIC 300 station. Now, select the profile rail from the hardware Catalog SIMATIC Technology CPU and drag and drop this into the configuration. Enter the Technology CPU 317T at slot 2 of the profile rail.

Carefully read the note that is displayed regarding the download of the system data and acknowledge with OK.

Figure 4-1 Note to download the system data
The properties windows - PROFIBUS interface DP(DRIVE) (R0/S3.1) is displayed.

Figure 4-2 Properties, PROFIBUS interface DP(DRIVE)

- In the window Properties - PROFIBUS interface DP(DRIVE) (S0/S3.1) window, press the New button in order to assign a network to the DP drive interface. The PROFIBUS configuration is set in the dialog box that is displayed. Please select the Network Settings tab.
  - Enter PROFIBUS address “2” as the highest address.
  - Set a transmission rate of 12 Mbit/s on the bus and DP as profile:

Figure 4-3 Properties, PROFIBUS sub-network
• Press the **Options** button and under the tab **Constant Bus Cycle** activate the check box **Activate constant bus cycle time**.

![Options dialog box](image)

**Figure 4-4** Activating the equidistant bus cycle

• Enter the desired cycle time, e.g. 3ms in the Isochronous DP cycle field. Take the possible cycle times for the particular motion control type from the following table:

<table>
<thead>
<tr>
<th>DP cycle time</th>
<th>Motion Control</th>
<th>Motion Control Performance 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 ms</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>2 ms</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>3 ms</td>
<td>X</td>
<td>X&lt;</td>
</tr>
</tbody>
</table>

X: Possible setting
::: Setting not possible

The other described settings are all shown for a DP cycle of 3 ms.

You can also make the settings using the properties dialog boxes of the drives. The isochronous DP cycle and the cycle time are then automatically activated or aligned.

Additional information regarding the settings for the DP cycle are provided in this product info in the Chapters "Setting-up an axis" and "Connecting MASTERDRIVES MC to the Technology CPU".
If you acknowledge the settings with OK, the configured objects are added to the SIMATIC 300 station.

Note
The X1-MPI/DP interface in the subrack is not networked for this example. It is set as default to a communications for MPI with 187.5 Mbaud. In order to download the technology system data onto the module, the data transfer rate of the interface should be set to ≥ 1.5 Mbaud.
- Add a MASTERDRIVES Compact Plus unit to PROFIBUS (e.g. with the address 3); this is in the hardware catalog under CPU 317T\PROFIBUS- \DP(DRIVE)\drives\MASTERDRIVES CBP2.

![Figure 4-6 Attaching a MASTERDRIVES Motion Control Plus to PROFIBUS](image)

- In the next window **Properties - Drive**, select the firmware version of the unit and acknowledge with **OK**.
In the **Configuration** tab of the **DP Slave Properties** window, select the pre-assignment of the **Standard message frame 5**.

![Figure 4-7 Setting standard telegram 5 at the slave](image)

Figure 4-7 Setting standard telegram 5 at the slave
• Under the **Isochronous operation** tab, activate the setting **Synchronize drive to equidistant DP cycle**:

![Figure 4-8 Activating clock cycle synchronization](image)

**Specifying the DP cycle**

The DP cycle must be set in the Technology CPU and in the MASTERDRIVES MC.

**Technology CPU**

In the Technology CPU, the pulse frequency is set - just the same as at MASTERDRIVES MC (determines the DP cycle) - and aligned to the DP cycle.
Commissioning

4.3 Creating a STEP 7 project

SIMOVERT MASTERDRIVES Motion Control

Parameter: P340 (pulse frequency)

Meaning:

The pulse frequency must be matched to the DP cycle so that the converter/inverter can be synchronized with this. Frequencies from 5 to 8 kHz can be set.

The following value should be set for the pulse frequency:

P340 = \frac{2 \text{task}}{\text{DP cycle time}}

This results in the following relationships between DP cycle time, pulse frequency and task:

<table>
<thead>
<tr>
<th>DP cycle time</th>
<th>Pulse frequency</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 ms</td>
<td>5.3 kHz</td>
<td>3 (only possible with Motion Control Performance 2)</td>
</tr>
<tr>
<td>2 ms</td>
<td>8 kHz</td>
<td>4</td>
</tr>
<tr>
<td>3 ms</td>
<td>5.3 kHz</td>
<td>4</td>
</tr>
</tbody>
</table>

This means, for a DP cycle of e.g. 3 ms, the pulse frequency P340 = 5.3 kHz. In this case, the restriction for pulse frequencies greater than 5.0 kHz should be taken into account as described under Chapter 2.2 (Section, Motion control)!

In the window for the CPU 317T, the pre-set value of 5.0 kHz is overwritten with 5.3 kHz in order to implement a DP cycle of 3 ms. Now, 3.019 ms is displayed as basis time:

![Figure 4-9 Adapting the pulse frequency](image)

Figure 4-9  Adapting the pulse frequency
• Overwrite the calculated value of the basis time, calculated from the pulse frequency of 5.3 kHz, from 3.019 ms with 3.000 ms and click on Align. The following settings are made when the button is pressed:
  – The equidistant bus cycle is activated
  – The DP cycle in the master system is aligned with the drive properties and set to 3.000 ms
  – All drive components of the same family receive the same parameterization

![Image of DP slave properties dialog box](image)

Figure 4-10  Adapting the DP cycle

• Click OK to confirm the changes.
You must then save and compile the project (Station > Save and compile). The consistency must also be checked (Station > Check consistency).

After these steps have been completed without any errors, you must download the hardware configuration into the Technology CPU (Target system > Load to module).

If you have changed the data transfer rate of the MPI/DP interface, then you must adapt the interface parameters in the PG/PC interface in order to be able to subsequently download the technology system data into the module.

The hardware configuration therefore still does not contain any technology system data. The generation of this data is separately activated in the hardware configuration. To do this, double click on index 3 (Technology) in the profile rail of the SIMATIC 300 station and change to the Technology system data tab. Activate Generate technology system data and save and compile and again download the configuration into the CPU.

Figure 4-11 Activating the Generate Technology System Data function
Note
The technology system data with the hardware configuration can also be downloaded in just one step in order to eliminate the second download. The procedure described has the advantage that the higher data transfer rate of the communications link can be used to download the technology system data therefore reducing the time required.

If the download operation has been successfully completed, only the green and yellow LEDs are lit. The red BF 3 LED can flash (the mode switch is in the STOP position). This bus error occurs if the PROFIBUS address and pulse frequency configured in the HWConfig have not yet been set on the MASTERDRIVES MC.

If the communication between the two devices is to be tested, the basic functions of the MASTERDRIVES MC should be commissioned according to the Chapter "Basic commissioning of the MASTERDRIVES MC" and the connection to MASTERDRIVES MC established according to the Chapter "Connecting MASTERDRIVES MC to the Technology CPU".

If the settings in the Technology CPU and in MASTERDRIVES MC match, the BF 3 error does not occur and the LEDs on the PROFIBUS module of the MASTERDRIVES MC flash in synchronism.

Result
This therefore completes the hardware configuration of the station and the window can be closed.

See also
- Connect MASTERDRIVES MC to the Technology-CPU (Page 77)
- Creating an axis (Page 26)
4.3 Creating a STEP 7 project

4.3.2 Creating an axis

Introduction

This step describes the procedure for creating an axis in S7T Config.

Procedure

- The "Technology Objects Management" is started by double clicking on the entry Technology objects in the Technology folder in the SIMATIC 300 station that has been set-up in the SIMATIC Manager.

![Figure 4-12 Technology objects in the SIMATIC Manager](image)

The Technology Objects Management opens. If no technology objects have been configured, then S7T Config is automatically started. Otherwise, start S7T Config by selecting, in the Technology Objects Management, the menu command Tools > Configure technology.

Note

You may also run S7T Config without using Technology Objects Management: To do this, select the object Technology objects in the folder Technology of the Technology CPU and start the S7T Config using the menu command Tools > Configure technology. This procedure is particularly useful when no new technology objects are to be created and consequently no technology data blocks need to be created.
4.3 Creating a STEP 7 project

- In S7T Config, open the **Axes** folder:

![Figure 4-13 Inserting an axis](image)

- The following window opens after double clicking on **Insert axis**:

![Figure 4-14 1st window of the axis configuration](image)
If you click on OK then the second window of the axis configuration opens. Here, enter the axis type and the motor type. In the example, the linear axis setting is retained:

Figure 4-15 2nd window of the axis configuration
- If you click on **Continue**, then the 3rd window of the axis configuration opens. The physical quantities are specified there. Do not change anything and click on **Continue**.

![3rd window of the axis configuration](image)

**Figure 4-16 3rd window of the axis configuration**
● The window for configuring the modulo axes opens. If necessary, activate the modulo axis and click on **Continue.**

![Image of Axis configuration window](attachment:image.png)

**Figure 4-17** 4th window of the axis configuration
The hardware configuration is automatically downloaded and in the drive window you can select the MASTERDRIVES CBP2 parameterized in HW Config. As telegram, enter **Standard message frame 5**. The maximum motor speed in this example is 6000 RPM. Select the function **Dynamic servo control (DSC)**.

**Figure 4-18  5th window of the axis configuration**

**Specifying the maximum motor speed**

The motor speed is set in the Technology CPU and in MASTERDRIVES MC (rated velocity).

**Technology CPU**

The maximum motor speed corresponds to the rated speed of the motor being used.
SIMOVERT MASTERDRIVES Motion Control

Parameter: P205 (rated velocity)

Meaning:

The rated velocity for the position control is dependent on the rated speed of the motor as well as the parameterized encoder resolution.

The value to be set in P205 is calculated according to the following formula:

\[ P205 = \text{rated speed [RPM]} \times 2^{P171} / 1000. \]

If, for example a motor is used which has a rated speed of 6000 RPM (P353) and a position resolution of \(2^{22}\) (P171), then a value 25165824 must be entered.

The encoder is configured in the next windows:

Configure the absolute encoder as ENDAT encoder, e.g. motor 1Fxxxx-xxxx-xExx as ENDAT 2048 pulses/revolution (refer to the following two diagrams).

![Figure 4-19 Axis configuration in S7T Config](image)
Connecting SIMOVERT MASTERDRIVES MC to the Technology-CPU
Product Information, 03/2008, A5E00272072-05

Figure 4-20   Axis configuration in S7T Config (enters the resolution of the absolute encoder)
Incremental encoders are appropriately set (squarewave TTL, sinusoidal, resolver) and the resolution is entered according to the manufacturer's data (refer to the following two diagrams), e.g. motor 1Fxxxxx-xxxxx-xAxx sin/cos.

Figure 4-21  Axis configuration in S7T Config (selects the encoder type for incremental encoders)
4.3 Creating a STEP 7 project

Connecting SIMOVERT MASTERDRIVES MC to the Technology-CPU
Product Information, 03/2008, A5E00272072-05

Specifying the encoder and the resolution

The encoder and its resolution must be specified in the Technology CPU and in MASTERDRIVES MC.
Technology CPU

The settings of the encoder used that are required for the Technology CPU are listed in the following table. Only the input values listed in the tables are evaluated for the respective encoder.

If a fine resolution 0 (standard) is set in the Technology CPU, this means a fine resolution of $2^{11} = 2048$. If a different value is set (e.g. 1024), this means the actual fine resolution.

Encoder parameters in SIMOTION are specified using parameters in the axis configuration windows or using the configuration data in the expert list as "TypeOfAxis.NumberOfEncoders.Encoder_1.xxx". The following assignments apply to the axis configuration windows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encoder type</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.encoderType</td>
</tr>
<tr>
<td>Encoder mode</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.encoderMode</td>
</tr>
<tr>
<td>Resolution</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolution</td>
</tr>
<tr>
<td></td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolution</td>
</tr>
<tr>
<td>Number of data bits</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsDataLength</td>
</tr>
<tr>
<td>Multiplication factor of the cyclic encoder</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.IncResolutionMultiplierCyclic</td>
</tr>
<tr>
<td></td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.IncEncoder.AbsResolutionMultiplierCyclic</td>
</tr>
<tr>
<td>Multiplication factor of the absolute encoder</td>
<td>TypeOfAxis.NumberOfEncoders.Encoder_1.AbsEncoder.AbsResolutionMultiplierAbsolute</td>
</tr>
</tbody>
</table>
SIMOVERT MASTERDRIVES Motion Control

The encoder used for the drive configuration is selected using the order number (motor rating plate).

The required settings of the parameters can be found in the following tables.

Parameter: U922 index 1 (encoder actual values)
Meaning:
The actual position value is connected to the encoder interface via U922.i001. With an absolute encoder, the absolute value from the encoder is specified as the actual position value. Please note that it takes a moment to read this value after initialization of the Motion Control system (the correct value is available).

If a resolver or encoder is used, connector KK120 (actual position value) must be set in U922.i001 (actual position value encoder interface). If, however, a multiturn encoder is used, the connector KK100 (absolute position) must be set in U922.i001 (actual position value encoder interface).

Parameter: P183 index 1 (position sensing configuration)
Meaning:
The position detection configuration is entered in this parameter.

The last digit enables position sensing.

xxx1 = Enable resolver/encoder
xxx2 = Enable multiturn encoder (x means not relevant)

Parameter: P171 (position resolution)
Meaning:
In MASTERDRIVES, the position resolution, including a fine resolution (multiplication factor), is specified. The resolution is specified as a power of two.

The position resolution must be set as follows:

\[ 2^{P171} = \text{encoder resolution} \times \text{multiplication factor of the cyclic encoder actual value} \]

i.e. for incremental encoders: \( \text{incResolution} \times \text{IncResolutionMultiplierCyclic} \)
i.e. for absolute value encoders: \( \text{AbsResolution} \times \text{AbsResolutionMultiplierCyclic} \)
### Encoder settings

<table>
<thead>
<tr>
<th>Encoder type</th>
<th>Vendor</th>
<th>Masterdrives MC-relevant settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSI multiturn encoder</td>
<td>SIEMENS 6FX2001-5HS24</td>
<td>Use as external encoder on Masterdrives MC:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P135:=4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P145.2:=15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P147.2:=3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P148.3:=12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P148.4:=12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P149.7:=0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P149.8:=0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P149.9:=0010</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P166.1:=1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>U950.18:=U950.17=3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMOTION:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encodersystem:=rotatory_system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encodertype:=sensor_absolute/absolute_cyclic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EncoderMode=SSI</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsEncoder.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Absresolution:=4096</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Absdatalength:=24</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsResolutionMultipliercyclic:=1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsResolutionMultiplierabsolute:=1</td>
</tr>
<tr>
<td>Endat motor encoder</td>
<td>Endat 2048 pulses/rev 1Fxxxxx-xxxxxx-xExx</td>
<td><strong>Masterdrives MC parameters:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>U922.1:=100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P171:=22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P183.1:=xxx2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIMOTION:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encodersystem:=rotatory_system</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encodertype:=sensor_absolute/absolute_cyclic</td>
</tr>
<tr>
<td></td>
<td></td>
<td>encoderMode=ENDAT</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsEncoder.Absresolution:=2048</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Absdatalength:=23</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsResolutionMultipliercyclic:=2048</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsResolutionMultiplierabsolute:=4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encoder system for motors with DRIVE-CLiQ interface: 1Fxxxxx-xxxxx-xExx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Encoder system for motors with DRIVE-CLiQ interface: 1Fxxxxx-xxxxx-xExx</td>
</tr>
</tbody>
</table>
## 4.3 Creating a STEP 7 project

<table>
<thead>
<tr>
<th>Encoder type</th>
<th>Vendor</th>
<th>Masterdrives MC-relevant settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EnDat motor encoder</strong></td>
<td><strong>Endat 512 pulses/rev 1Fxxxxx-xxxxx-xHxx</strong></td>
<td><strong>Masterdrives MC parameters:</strong></td>
</tr>
<tr>
<td></td>
<td>Encoder system for motors with DRIVE-CLiQ interface: 1Fxxxxx-xxxxx-xLxx</td>
<td>U922.1:=100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P171:=20</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P183.1:=xxx2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P148.1:=9</td>
</tr>
<tr>
<td></td>
<td><strong>SIMOTION:</strong></td>
<td>EncoderMode=ENDAT</td>
</tr>
<tr>
<td></td>
<td>Encodersystem:=rotatory_system</td>
<td>AbsEncoder.Absresolution:=512</td>
</tr>
<tr>
<td></td>
<td>Encodertype:=sensor_absolute/absolute_cyclic</td>
<td>Absdatalength:=21</td>
</tr>
<tr>
<td></td>
<td>encoderMode=ENDAT</td>
<td>AbsResolutionMultipliercyclic:=2048</td>
</tr>
<tr>
<td></td>
<td>AbsEncoder.Absresolution:=512</td>
<td>AbsResolutionMultiplierabsolute:=4</td>
</tr>
<tr>
<td><strong>EnDat motor encoder</strong></td>
<td><strong>Endat 32 pulses/rev 1Fxxxxx-xxxxx-xGxx</strong></td>
<td><strong>Masterdrives MC parameters:</strong></td>
</tr>
<tr>
<td></td>
<td>Encoder system for motors with DRIVE-CLiQ interface: 1Fxxxxx-xxxxx-xDxx</td>
<td>U922.1:=100</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P171:=12</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P183.1:=xxx2</td>
</tr>
<tr>
<td><strong>SIMOTION:</strong></td>
<td>EncoderMode=ENDAT</td>
<td>AbsEncoder.Absresolution:=32</td>
</tr>
<tr>
<td></td>
<td>Absdatasize:=17</td>
<td>AbsResolutionMultipliercyclic:=128</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AbsResolutionMultiplierabsolute:=4</td>
</tr>
<tr>
<td><strong>Incremental sin/cos motor encoder</strong></td>
<td><strong>optical incremental encoder sin/cos 1 Vpp 2048 pulses/rev ERN1381 / 1387 1Fxxxxx-xxxxx-xAxx</strong></td>
<td><strong>Masterdrives MC parameters:</strong></td>
</tr>
<tr>
<td></td>
<td>Encoder system for motors with DRIVE-CLiQ interface: 1Fxxxxx-xxxxx-xDxx</td>
<td>U922.1:=120</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P171:=22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P183.1:=xxx1</td>
</tr>
<tr>
<td><strong>SIMOTION:</strong></td>
<td>EncoderMode=sinus_vpp</td>
<td>IncEncoder.IncResolution:=2048</td>
</tr>
<tr>
<td></td>
<td>Encodersystem:=rotatory_system</td>
<td>IncResolutionMultipliercyclic:=2048</td>
</tr>
<tr>
<td></td>
<td>Encodertype:=sensor_incremental</td>
<td>For incremental encoders, a fine resolution of 0 (default value) in the IncResolutionMultipliercyclic parameter means a fine resolution of $2^{11} = 2048$</td>
</tr>
</tbody>
</table>
### 4.3 Creating a STEP 7 project

**Commissioning**

<table>
<thead>
<tr>
<th>Encoder type</th>
<th>Vendor</th>
<th>Masterdrives MC-relevant settings</th>
</tr>
</thead>
</table>
| Resolver     | 2-pin: 1Fxxxxx-xxxxx-xTxx  
               multi-pin: 1Fxxxxx-4xxxx-xSxx  
               Encoder system for motors with DRIVE-CLIQ interface:  
               2-pin: 1Fxxxxx-xxxxx-xPxx  
               multi-pin: 1Fxxxxx-4xxxx-xUxx | **Masterdrives MC parameters:**  
               U922.1:=120  
               P183.1:=xxx1  
               P171:= 11 (2 pole)  
               12 (4 pole)  
               13 (6 pole)  
               13 (8 pole)  
               **SIMOTION:**  
               Encodersystem:=rotatory_system  
               Encodertype:= sensor_incremental  
               encoderMode=RESOLVER  
               IncEncoder.IncResolution:=1 (2 pole)  
               2 (4 pole)  
               4 (6 pole)  
               4 (8 pole)  
               **Comment on P171:**  
               The value is calculated using the formula:  
               P171=11+x;  
               In this case, x=log2 (n/2) with  
               - x should be rounded-off to the top as integer number  
               - log2 is the logarithm to base 2  
               - n is the pole number of the resolver  
               **Comment to IncEncoder.IncResolution:**  
               This value is calculated from P171 using the formula:  
               IncResolution = 2(P171-11) |
Differences between ABS and CYCLE_ABS:

- In the case of ABS, the absolute actual position of the encoder is assumed after powering up the Technology CPU or following an encoder error.

- In the case of CYCL_ABS, overflows of the encoder ranges are tracked in the NVRAM and taken into account when the cycle is resumed.

  The encoder must be calibrated after the initial loading.

  If the settings for the absolute encoder are modified, the encoder must also be readjusted.

  With the CPU switched off, the encoder may only be moved a maximum distance ≤ "half the encoder range" in both traversing directions in order to still be able to detect the exact position.

- Finally click on **Complete**. The set data will be summarized:

![Figure 4-23 Last window of the axis configuration](image)

Once you have created the axis, certain further settings need to be entered, in order to optimize the interaction between the Technology CPU and MASTERDRIVES MC.
Following error monitoring

To prevent the following error monitoring interrupting an axis motion, it can be set to a higher value or deactivated. A high following error can occur, for example, as a result of the fact that the drive was not optimized.

To do this the Monitoring window of the axis that was created is called and the setting Dynamic following error monitoring active is de-selected under the Following error monitoring tab.

The following error monitoring should, of course, be matched to the requirements and mechanical system of the plant when commissioning an application.

⚠️ WARNING

If the following error monitoring is increased or deactivated, larger incorrect movement can occur at the axis in the case of an error (e.g. incorrect position control direction). This is particularly important, for example, when the axis only has a limited traversing range.

![De-activating the following error monitoring](image)

Figure 4-24  De-activating the following error monitoring
Position controller configuration

In S7T Config, select the control of the axis.
The window of the **Closed-loop controller** is opened and the \( K_v \) factor, the speed pre-control and the velocity-dependent interpolation are set. The **Dynamic Servo control (DSC)** function remains selected:
Setting the system clock cycles

Right-click Technology and select the Set system clock cycles entry in the context menu.

The following window opens:

![System Cycle Clocks: Technology](image)

Figure 4-25 Setting the system clock cycles

Specifying the system clock cycles

The specification of the system clock cycles in the Technology CPU affects the position reference value adaptation in MASTERDRIVES MC.

Technology CPU

The ratio of the DP clock cycle to the position controller clock cycle and to the interpolator clock cycle (diagram above) is, e.g. set to 1:2:2. This represents a DP clock cycle of 3 ms, a position controller clock cycle of 6 ms and an interpolator clock cycle of 6 ms.

To activate and use the interpolator clock cycle 2, refer to the online documentation in S7T Config.
Commissioning
4.3 Creating a STEP 7 project

SIMOVERT MASTERDRIVES Motion Control

Parameter: P770 (time slice interpolator)

Meaning:
The transition from the position controller clock cycle (Technology CPU) to the sampling time of the position controller (motion control) is fed through an interpolator that aligns the ratio.

- **Up to MASTERDRIVES software Version V2.2**
The ratio can only be specified in the form position controller clock cycle/DP cycle=2(P770-1).

  This means that if, for example, the DP cycle and the position controller clock cycle are the same, you must enter a value of 1 into P770. If the position controller clock cycle is double the DP cycle, you must set the value to 2.

- **From MASTERDRIVES software Version V2.2**
The ratio can only be specified in the form position controller clock cycle/DP cycle=2(P770-3).

  If the DP cycle and the position controller clock cycle are the same, then you must enter the value 3 in P770. If the position controller clock cycle is double the DP cycle, you must set the value to 4.

**Task monitoring time**
The task monitoring time monitors the processing of the Motion Control jobs.

**Technology DB update**
The setting for the time of the technology DB update determines the time intervals in which the technology DBs in the S7 will be updated.

**Maximum task processing**
Time monitoring (watchdog) for processing tasks when the CPU transitions from RUN to STOP.

**Number of the tolerated IPO and IPO2 overflows**
An "IPO overflow" will occur if the processing of the interpolator (IPO or IPO2) lasts longer than the configured interpolator clock cycle. In this case the following interpolator cannot be started in the selected cycle and will be omitted. If the processing of the interpolator is completed at the next cycle, it will be started as usual.

  Each omitted interpolator will be counted as "IPO overflow". Set in the selection list how many successive "IPO overflows" are tolerated before the technology CPU switches to the STOP operation mode.
Correcting of system-related deadtimes

The system compensates the system-related deadtimes (deadtimes after the optimized DP cycle). With the coupling between the control and MASTERDRIVES MC, additional deadtimes occur, that are dependent on the DB cycle and the firmware release of the MC. In order to compensate these additional deadtimes, the configuration data must be appropriately configured.

Using the righthand mouse key, click on the axis and select Expert > Expert list:

Figure 4-26  Calling the expert list
Under the configuration data `TypeofAxis.SystemDeadTimeData.additionalTime` enter the appropriate value from the table below.

![Input window to correct the system-related deadtime](image)

Figure 4-27 Input window to correct the system-related deadtime

<table>
<thead>
<tr>
<th>DP cycle time</th>
<th>Motion Control up to SW V2.2</th>
<th>Motion Control as of SW V2.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 ms</td>
<td>0.003 s (only possible with Motion Control Performance 2)</td>
<td>0.001875 s</td>
</tr>
<tr>
<td>2 ms</td>
<td>0.002 s</td>
<td>0.001750 s</td>
</tr>
<tr>
<td>3 ms</td>
<td>0.003 s</td>
<td>0.002625 s</td>
</tr>
</tbody>
</table>
4.3.3 Referencing

Defining the referencing mode

If the connected axis is to be referenced, the referencing mode must be specified in both the Technology-CPU and MASTERDRIVES MC.

Referencing mode "External zero mark only"

Operational sequence:

- When a defined edge of the external zero mark is crossed, the position is accepted.

Hardware structure:

![Diagram of Referencing (External zero mark only)]
4.3 Creating a STEP 7 project

Technology-CPU

If **External zero mark only** is selected as the referencing mode, the approach direction can be selected by means of **Start search for reference**.

**Signal transition** and **To side of external zero mark** have no significance, as in motion control with the parameterization of the script file "STDTLG5_T4_V21.ssc" the positive signal edge is always evaluated.

![Referencing the axis in STEP 7 (referencing mode, only external zero mark)](image)

Figure 4-29  Referencing the axis in STEP 7 (referencing mode, only external zero mark)
SIMOVERT MASTERDRIVES Motion Control

The reference cam should be connected to digital input 4 (interrupt-capable inputs / terminal X101/6) of Motion Control. With the script file "STDTLG5_V14A.ssc", the digital inputs 4 or 5 (interrupt-capable inputs/terminals X101/6 or X101/7) are configured as measuring input 1 (digital input 4 X101/6) and measuring input 2 (digital input 5 X101/7) and should be addressed via the Technology-CPU. Digital input 4 can be used as reference cam and as measuring input and digital input 5 can be used as measuring input.

The parameterization of U922.i005 and U923.i001 in Motion Control should be set to KK122 and B212 for MASTERDRIVES MC in accordance with the description below. As the zero position is of no significance here, the parameterization of the 2nd position of P183.i001 has no effect.

Referencing mode "Encoder zero mark only"

Operational sequence

A reference cam signal is not necessary. The position is accepted at the next zero mark of the encoder.
If **Encoder zero mark only** is selected as the referencing mode (diagram below), the approach direction can be selected by means of **Start search for reference**.

![Axis referencing in STEP 7 (referencing mode, only encoder zero mark)](image)

**SIMOVERT MASTERDRIVES Motion Control**

The search for reference direction must be compatible with the parameterization of the 2nd digit of P183.i001 in the Motion Control. If **negative direction** ... is selected in the window (diagram above), P183.i001=xx2x must be entered in the Motion Control. If **positive direction** ... is selected, then P183.i001 = xx1x must be set in the Motion Control.

(The parameterization of U922.i005 and U923.i001 in Motion Control must be left at its standard values KK120 and B210 corresponding to the following description.)
Referencing mode "Referencing cam and encoder zero mark"

Operational sequence

The axis searches in the specified direction for the reference point. Once the reference cam signal is reached, the axis velocity changes from the reference point approach velocity to the reference point creep velocity. Once the reference cam has been left, the axis is referenced at the next zero mark of the encoder that is detected.

Hardware configuration

The reference cam is connected to a free SIMATIC input (either at an input integrated in the Technology-CPU or at distributed input at DP(DRIVE)).

Figure 4-31  Referencing (reference cam and encoder zero mark)

Technology-CPU

If "Reference cam and encoder zero mark" is selected as referencing mode (the following two diagrams), then the evaluation position of the zero mark can be selected using Encoder zero mark and the approach direction can be selected via Search for reference direction.
4.3 Creating a STEP 7 project

SIMOVERT MASTERDRIVES Motion Control

The settings of the Technology-CPU must be compatible with the parameterization of the 2nd digit of P183.i001 in the Motion Control. This means: If, as **Start search for reference** is selected in the window **Negative direction** and for **Zero mark "Behind reference cam"**, then P183.i001 must be xx2x in Motion Control and if **Negative direction** is selected and for **Encoder zero marks "In front of reference cam"**, then P183.i001=xx1x must be in Motion Control. If, on the other hand as **Start search for reference** in the **Positive direction** is selected in the window and for **Encoder zero mark "behind reference cam"** (the following two diagrams), then P183.i001 must be xx1x in Motion Control, if **Positive direction** is selected and for **Encoder zero mark "In front of reference cam"**, then P183.i001 must be xx2x in Motion Control.

(The parameterization of U922.i005 and U923.i001 in Motion Control must be left at its standard values KK120 and B210 corresponding to the following description.)

The reference cam should be connected to the input integrated in the Technology-CPU or at the distributed input at DP(DRIVE), that was configured in the window reference axis (the following two diagrams). When this reference cam is reached, the referencing function is enabled in the drive.

![Figure 4-32 Axis referencing in STEP 7 (referencing mode, reference cams and encoder zero mark)](image)
Figure 4-33  Axis referencing in STEP 7 (referencing mode, reference cams and encoder zero mark)

Parameter: U922 index 5 (encoder actual values)

Significance:

The reference value is connected to the encoder interface via U922.i005. If reference cam and encoder zero mark or encoder zero mark only are used for referencing, then referencing is performed using the reference point detection in the Motion Control. However, if only a reference cam is used for referencing, the position measured value memory in Motion Control is used for referencing.

If reference cam and encoder zero mark or encoder zero mark only are used for referencing, then connector KK124 (reference point measured value) should be set in U922.i005 (encoder interface reference value).

If only a reference cam is to be used for referencing, then connector KK122 (position measured value memory) should be set in U922.i005 (encoder interface reference value).

Parameter: U923 index 1 (encoder feedback signal)
Significance:
The "Reference point detected" feedback signal (acknowledgement) is connected to the encoder interface via U923.i001. If reference cam and encoder zero mark or encoder zero mark only are used for referencing, then referencing is performed using the reference point detection in the Motion Control. However, if only a reference cam is used for referencing, the position measured value memory in Motion Control is used for referencing.

However, if reference cams and encoder zero mark or encoder zero mark only are used for referencing, binector B210 (reference point detected acknowledgement) should be set in U923.i001 (reference value detected checkback signal, encoder interface).

If however, only reference cams are to be used for referencing, binector B212 (acknowledgement that the measured value is valid) should be set in U923.i001 (reference value detected checkback signal, encoder interface).

Parameter: P183 index 1 (position sensing configuration)
Significance:
The position detection configuration is entered in this parameter.
xx1x = The 1st zero position to the right of the coarse pulse (reference cam) is evaluated.
xx2x = The 1st zero position to the left of the coarse pulse (reference cam) is evaluated.
(x means not relevant)
The STEP 7 project is now configured. The MASTERDRIVES MC is set in the next step.
4.3.4  "Measuring" function

Description

You can use the "measuring" function to detect the actual position of an axis at any time. A typical application is the acquisition of a print mark for the purpose of synchronizing the axis to this mark.

Hardware structure

The measuring input must be connected to fast input X101/6. The input is isolated. This enables more than one input to be connected in parallel, whereby the reference potential of the 24V supply of the measuring input (for example, from the line supply) must also be wired.

Figure 4-34  Measuring
Technology CPU

Insert a measuring input under the axis in the "Measuring input" folder.

Two measuring inputs can be connected to MASTERDRIVE:

- Measuring input 1 to X101/6
- Measuring input 2 to X101/7

Only one measuring input can be activated at any time. Before you, for example, activate measuring input 2, you must ensure that measuring input 1 is not active. The measuring input number should be assigned as follows:

- Measuring input 1 → measuring input number: "1"
- Measuring input 2 → measuring input number: "2"

Figure 4-35 Inserting a measuring input
4.3 Creating a STEP 7 project

Connecting SIMOVERT MASTERDRIVES MC to the Technology-CPU
Product Information, 03/2008, A5E00272072-05
**SIMOVERT MASTERDRIVES Motion Control**

Select the signal edge using the technology function MC_MeasuringInput in the user program:

- rising edge
- falling edge

If you select another setting, the last valid value is taken over (rising or falling).

### Response times for the measuring function

With the Technology CPU, the measuring function can be used in various configurations. Depending on the connection of the axis (via PROFIBUS-DP) and the processing level (position controller clock cycle or interpolator clock cycle) you must take into account different response times for the measurement function in the application itself.

In the user program, measuring is controlled by calling the function block **MC_MeasuringInput**. You can specify when the measuring function is to be active during the call:

- immediately (without measuring window/active range)
  
  \[ \text{StartPosition} = \text{EndPosition} \]

- within a position-dependent measuring window
  
  \[ \text{StartPosition} \neq \text{EndPosition} \]

For **Measuring without measuring window** with MC_MeasuringInput, the measuring input is immediately activated.

The runtime up to the evaluation of the measured signal edge at the hardware input is dependent on the configuration (refer to Table 1-1). To be certain to detect the measuring edge, you must ensure that MC_MeasuringInput is executed earlier by this amount of runtime in the user program.

When **Measuring with measuring window**, the task is only registered in the system with MC_MeasuringInput. The measuring input is only activated when the axis is at the beginning of the measuring window.

The runtime from reaching the start of the measuring window on the axis (mechanics) to evaluating the measured signal edge at the hardware input is dependent on the configuration (refer to Table 1-2). In order that the measuring input is active at the axis when the beginning of the measuring window is reached, when calling the function, you must bring the start of the measuring window forwards depending on the axis velocity and response time.

This also appropriately applies for the end of the measuring window. It is important that the measuring input is no longer active when the end of the measuring window on the axis (mechanical) is passed.

These runtimes can only be compensated using the configuration data MeasuringRange.activationTime (or in the diagram "Probe configuration" in the input field "Activation time of probe measuring range")

### Note

The offset of the measuring window only functions reliably when the axis velocity

- Within the measuring window is constant and is
- Known before the function call.
You can determine the response times for your configuration using the following tables. The values in the tables refer to the selected system clock cycles. By using the actual times, you can calculate the response time in milliseconds.

The following abbreviations are used in the tables:
(IS) Interpolator or position controller clock cycle (this can be selected when configuring the measuring input)
(DP) Cycle time on the PROFIBUS DP
(DR) Cycle time in the drive (time slice in which the measuring function is evaluated)

### Table 4-1  Measuring without measuring window

<table>
<thead>
<tr>
<th>Component</th>
<th>MASTERDRIVES MC</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_MeasuringInput</td>
<td>3 (IS) + 3 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>→ ready to detect the measuring edge</td>
<td></td>
</tr>
<tr>
<td>Detecting the measuring edge</td>
<td>2 (IS) + 8 (DP)</td>
</tr>
<tr>
<td>→ result in the Technology CPU for further processing</td>
<td></td>
</tr>
<tr>
<td>Total minimum time between 2 measurements *)</td>
<td>5 (IS) + 11 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>*) In addition, the restrictions of the system must be taken into account.</td>
<td></td>
</tr>
</tbody>
</table>

### Table 4-2  Measuring with measuring window: Measuring edge is detected in the window

<table>
<thead>
<tr>
<th>Component</th>
<th>MASTERDRIVES MC</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_MeasuringInput</td>
<td>2 (IS)</td>
</tr>
<tr>
<td>→ ready to evaluate the measuring range (start of the measuring window)</td>
<td></td>
</tr>
<tr>
<td>Reaching the start of the measuring window at the axis (mechanical system)</td>
<td>2 (IS) + 3 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>→ ready to detect the measuring edge</td>
<td></td>
</tr>
<tr>
<td>Detecting the measuring edge</td>
<td>2 (IS) + 8 (DP)</td>
</tr>
<tr>
<td>→ result in the Technology CPU for further processing</td>
<td></td>
</tr>
<tr>
<td>Total minimum time between 2 measurements *)</td>
<td>5 (IS) + 11 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>*) In addition, the restrictions of the system must be taken into account.</td>
<td></td>
</tr>
</tbody>
</table>

### Table 4-3  Measuring with measuring window: No measuring edge in the window

<table>
<thead>
<tr>
<th>Component</th>
<th>MASTERDRIVES MC</th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_MeasuringInput</td>
<td>2 (IS)</td>
</tr>
<tr>
<td>→ ready to evaluate the measuring range (start of the measuring window)</td>
<td></td>
</tr>
<tr>
<td>Reaching the start of the measuring window at the axis (mechanical system)</td>
<td>2 (IS) + 3 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>→ ready to detect the measuring edge</td>
<td></td>
</tr>
<tr>
<td>Reaching the start of the measuring window at the axis (mechanical system)</td>
<td>2 (IS) + 3 (DP) + 2 (DR)</td>
</tr>
<tr>
<td>→ reset: &quot;Ready to detect the measuring edge&quot;</td>
<td></td>
</tr>
<tr>
<td>Resetting the measure ready signal</td>
<td>2 (IS) + 8 (DP)</td>
</tr>
<tr>
<td>→ feedback to the Technology CPU to continue processing</td>
<td></td>
</tr>
<tr>
<td>Total minimum time between 2 measurements *)</td>
<td>7 (IS) + 14 (DP) + 4 (DR)</td>
</tr>
<tr>
<td>*) In addition, the restrictions of the system must be taken into account.</td>
<td></td>
</tr>
</tbody>
</table>
4.3 Creating a STEP 7 project

Download the program into the Technology CPU and switching to RUN

Save and compile the technological settings.

The mode switch of the Technology CPU is always at STOP.

The connection to the Technology CPU is established using Technology ® Connect to target system.

The project is downloaded into the Technology CPU using Technology ® Load to target system.

After the project has been downloaded into the target system, switch the Technology CPU to RUN using the mode switch.

Creating the technology DBs

If the configuration with S7T Config has been completed, for the technology objects that have been created (e.g. axes, cams, measuring inputs), technology data blocks must be created. To do this, the Technology Objects Management tool is used.

Change to Technology Objects Management if it is still open. Otherwise, start the tool by double clicking on the technology objects entry in the Technology folder of the SIMATIC station.

Figure 4-38 Start Technology Objects Management using the SIMATIC Manager
The Tool Technology Objects Management starts with the following dialog box.

The lower halves of the dialog box window show the technology objects that are either configured in S7T Config or are available as standard, but for which a TO-DB still does not exist. If required, adapt the data block numbers of the TO-DBs and click on Create in order to generate the DBs.
If the existing technology objects TO-DBs were generated, then they are displayed in the upper window halves in Technology Objects Management. The tool can now be exited.

The TO-DBs that were created are now in the Blocks folder of the SIMATIC 300 station. The symbols for the DBs are derived from the designations in the configuration - if required, UDTs are added.

![Figure 4-41 TO-DBs in the SIMATIC Manager](image)

### 4.3.5 Activating a brake

#### 4.3.5.1 Vertical axis application case

**Introduction**

When a braking sequential control is used in conjunction with a vertical axis, the axis should remain at its position when the system is shutdown or in a fault situation.

The axis enable can be reset by an alarm in the technology CPU or by disabling the MC_Power function (Enable input = false).

The extended brake control should allow the ON/OFF1, OFF2, OFF3 and enable operation (enable pulse) bits to be switched off sequentially. This ensures that the brake is already closed when the pulse enable for the axis is disabled, thus preventing the axis from twisting / sagging.
4.3.5.2 Activating braking sequential control in the axis

Introduction

The enable bits ON/OFF1, OFF2, OFF3 and operation enable (pulse enable) of the axis are coordinated via the braking control that is integrated in the drive. This means that, when the axis is switched off normally or in the event of an axis error, you can make sure that the brake is already closed before the pulse enable is cancelled, hence preventing the axis from sagging.

There are two different operating states:
- Switch axis on / off normally using MC_Power
- Switch off the axis in the event of axis errors with error response "RELEASE_DISABLE"

Procedure for configuring switching the axis on / off normally using MC_Power

You configure an axis to switch on / off normally with braking control using the stop modes on the MC_Power block:

<table>
<thead>
<tr>
<th>Stop mode</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Coast stop (OFF2)</td>
<td>The drive coasts to a standstill without power; the brake closes immediately</td>
</tr>
<tr>
<td>5</td>
<td>Ramp stop (OFF1)</td>
<td>Stops the axis via the ramp function encoder</td>
</tr>
<tr>
<td>6</td>
<td>Fast stop (OFF3)</td>
<td>Stops the axis via a fast stop ramp</td>
</tr>
</tbody>
</table>

You will find further information in the Online Help for the MC_Power block.
4.3 Creating a STEP 7 project

Procedure for configuring the axis response to axis errors with error response "RELEASE_DISABLE"

The response of the axis to axis errors with the "RELEASE_DISABLE" error response is set by changing the configuration in S7T Config.

- Switch to the configuration dialog for the axis, and click the "Drive settings ..." button.

![Configuration Dialog](image-url)
• Select the required response by the axis to axis errors with an error response "RELEASE_DISABLE".

Ramp stop (OFF1):

Braking takes place at the drive's ramp function encoder ramp. When the speed threshold is reached, the holding brake is enabled which disables the pulse enable once the brake closing time has elapsed.

![Diagram of ramp stop (OFF1)]
Coast stop (OFF2):
In this case the power enable is cancelled immediately, and the drive costs to a standstill. In parallel, the mechanical braking control is enabled immediately. This engages the brake, which actively brakes the drive. The mechanical stress on the brake depends on the load to which it is subjected.
Fast stop (OFF3):
The drive is braked at the fast stop ramp (emergency stop). When the speed threshold is reached, the holding brake is enabled which disables the pulse enable once the brake closing time has elapsed.
4.3 Creating a STEP 7 project

4.3.5.3 Activating the braking control in the MASTERDRIVE MC

Introduction

The automatic braking control that is already integrated into the MASTERDRIVES basic software can be activated with P605 = 1 or with P605 = 2 for brakes with checkback contact(s). Output signals from the braking control are the "open brake" B0275 and "close brake" B0276 binectors.

Activating the braking control

The following parameters are available for the "motor holding brake" function:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| P605      | 1 = activate braking control (without checkback)  
            | 2 = activate braking control (with checkback) |
| P606      | Brake opening time |
| P607      | Brake closing time |
| P608      | Q. open brake |
| P609      | Q. close brake |
| P610      | Q. brake threshold 1 |
| P611      | adjustable limit alarm monitor |
| P612      | Q.RM brake open |
| P613      | Q.RM brake closed |
| P614      | Q.close holding brake |
| P615      | Q. brake threshold 2 |

Allocating the brake activation function to the digital output

You must assign the output of the B0275 "open brake" braking control binector to a digital output of the MASTERDRIVE. If you do not use an add-on module, you can use the terminals -X101.3 to -X101.6. Enter the binector value B0275 "open brake" in the parameter assigned to the digital output.

| P651.B(0) | Digital input / output 1 terminal -X101.3 |
| P652.B(0) | Digital input / output 2 terminal -X101.4 |
| P653.B(0) | Digital input / output 3 terminal -X101.5 |
| P654.B(0) | Digital input / output 4 terminal -X101.6 |
Example:

You use digital output 1 (terminal X101.3) to activate the brake. Connect the Open brake binary signal to the digital output by entering the binector value B0275 in parameter P651.B(0).

![Diagram of MASTERDRIVES MC connection](image-url)

- 24 V
- X101.1
- X101.3
- X101.2
- Motor with motor holding brake
- 0 V
4.4 Basic commissioning of MASTERDRIVES MC

Procedure

One of the commissioning tools, Drive Monitor or Drive ES, is used to commission the Masterdrives MC. If the connection is established via the USS serial interface, it should be ensured that the bus address in parameter P700 and the baud rate in parameter P701 (6 → 9600 baud, 7 → 19200 baud, 8 → 38400 baud) correspond to the settings in the commissioning tool used. A brief explanation as to how a connection is established to MASTERDRIVES MC using the commissioning tool is provided in the Section "MASTERDRIVES MC commissioning tool (Page 87)."

The first step in the guided commissioning procedure is to configure the hardware (power unit, motor, encoder, etc. used), the interfaces etc. This is performed using one of the commissioning tools by calling the menu item Parameters > Controlled start-up > Basic functions.

- For motion control devices, select the power unit in the 1st Configuration window according to the Order No. of the converter and enter the supply voltage. For Motion Control Compact Plus units, it is only necessary to parameterize the supply voltage. The power unit of this device cannot be changed and it is automatically detected and displayed with a gray background (like the individual slot assignments).

![Configuration window](image)

Figure 4-42 Guided commissioning of the basic device: 1. Configuration window
4.4 Basic commissioning of MASTERDRIVES MC

- Select the connected motor in the 2nd window **Motor**:

![Figure 4-43 Guided commissioning of the basic device: 2. Motor window](image)

- Select the connected motor encoder in the 3rd window **Motor encoder**:

![Figure 4-44 Guided commissioning of the basic device: 3. Motor encoder window](image)
4.4 Basic commissioning of MASTERDRIVES MC

- In the 4th window **Setpoints, control type**, select **PROFIBUS-DP and terminal strip**:

![Diagram showing the 4th window for Setpoints, control type](image)

- The optimized speed controller parameters (Kp and Tn), torque limits etc. can be entered in the 5th window **Control** and window 6 **Inputs/outputs** can be run through without making any changes with **Continue**.

Figure 4-45  Guided commissioning of the basic device: 4. Setpoints and control type window
4.4 Basic commissioning of MASTERDRIVES MC

- The PROFIBUS address is set in the 7th window Communication:

![Diagram of PROFIBUS address setting]

- At the end of the guided commissioning, a summary of the parameterization is displayed.

![Diagram of guided commissioning summary]

- Connecting SIMOVERT MASTERDRIVES MC to the Technology-CPU

Product Information, 03/2008, A5E00272072-05
4.4 Basic commissioning of MASTERDRIVES MC

- If you click on **Accept configuration** and you acknowledge your entries with **OK** and **Continue**, the parameter assignments are downloaded into the drive converter.
  
  Successful loading of the parameter assignments is confirmed in the following window.

![Configuration transfer](image)

Figure 4-48  Message that the parameter assignments were successfully accepted

The basic unit commissioning has now been completed and you can continue with connecting the MASTERDRIVES MC to the Technology CPU.

See also

MASTERDRIVES MC commissioning tool (Page 87)
4.5 Connect MASTERDRIVES MC to the Technology-CPU

**Note**
MASTERDRIVES MC can only be operated at the Technology CPU in conformance with PROFI Drive. The script files supplied ensure that the system operates in conformance with PROFI Drive.

**Introduction**

In this step, the system is parameterized for connecting the Motion Control to the Technology CPU for standard telegram type 5. This is performed corresponding to the DP cycle time using the script file according to the table:

<table>
<thead>
<tr>
<th>DP cycle time</th>
<th>Script file</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.5 ms</td>
<td>STDTLG5_T3_V21.ssc (only possible with Motion Control Performance 2)</td>
</tr>
<tr>
<td>2 ms</td>
<td>STDTLG5_T4_V21.ssc</td>
</tr>
<tr>
<td>3 ms</td>
<td></td>
</tr>
</tbody>
</table>

The appropriate script file implements the following parameter assignments / functionalities on the Motion Control converter/inverter:

- All digital outputs and speed setpoint interconnections are reset
- To start instructions are provided in a message box to set parameters that are dependent on the application (please read these carefully), that should be set in the following dialog box.

  All of the parameters that depend on the application have already been explained in the Chapter "Create a STEP 7 project". Examples are parameters U922 and U923 (encoder interface), which have to be modified etc. depending on the application (e.g. referencing with encoder zero mark or only with reference cams).

- Errors occurring after Power On are automatically acknowledged.
- The SST1 interface is located in the T6 time slice.
- Motor potentiometer functionality is excluded from the time slice.
- The DSC kernel function is implemented with free blocks.
- Interconnection of free modules to implement the functions, referencing only with referencecams and measuring.
- Connecting process data of the standard telegram 5 in the converter/inverter etc.
- Wiring of the motor encoder interface. (A connection of the encoder interface external coder is not implemented).

**NOTICE**

A basic commissioning of the drive must be performed in the Drive Monitor before using the script.
**Commissioning**

4.5 Connect MASTERDRIVES MC to the Technology-CPU

**Procedure**

The following section describes the procedure to run the script file "STDTLG5_T4_V21.ssc":

- With Drive Monitor / Drive ES click on the field **Execute script file...** under the menu item **File**, select the script file "STDTLG5_T4_V21.ssc" for standard telegram 5 and open this.

**Note**

The 6SE70MC converter/inverter may not be in the "Run" state (r001=14).

The possible settings for the sources of the digital outputs for "Parameter > Controlled start-up > Basic functions" are reset at the next "Execute script file..."!

- You are now guided ONLINE via WINDOWS windows. The script file should first be started:

  ![Figure 4-49 Starting the script file "STDTLG5_T4_V21.ssc"](image)

- After the start you must accept the liability exclusion clause and acknowledge the connection of the Motion Control to the Technology CPU for standard telegram 5.

**Note**

You can stop the execution of the script file at any time using the Cancel button.

- Carefully read the contents of the message box with the setting information for the application-dependent parameter P340 (pulse frequency) and acknowledge the message.

  ![Figure 4-50 Message box with setting information for P340](image)
• Set the required value in the dialog box for the application-dependent parameter P340 (pulse frequency):

![Figure 4-51 Dialog box for setting P340](image)

• Carefully read the contents of the message box with the setting information for the application-dependent parameter U922.i001 (actual position value of the encoder interface) and acknowledge this message.

![Figure 4-52 Message box with setting information for U922.i001](image)
• Set the required value in the dialog box for the application-dependent parameter U922.i001 (encoder interface position actual value):

![Dialog box for setting U922.i001](image1)

Figure 4-53  Dialog box for setting U922.i001

• Carefully read the contents of the message box with the setting information for the application-dependent parameter U922.i005 (reference value of the encoder interface) and acknowledge this message.

![Message box with setting information for U922.i005](image2)

Figure 4-54  Message box with setting information for U922.i005
Set the required value in the dialog box for the application-dependent parameter U922.i005 (reference value of the encoder interface):

![Figure 4-55 Dialog box for setting U922.i005](image)

Carefully read the contents of the message box with the setting information for the application-dependent parameter U923.i001 (reference point checkback signal of the encoder interface) and acknowledge this message.

![Figure 4-56 Message box with setting information for U923.i001](image)
4.5 Connect MASTERDRIVES MC to the Technology-CPU

- Set the required value in the dialog box for the application-dependent parameter U923.i001 (reference point checkback signal of the encoder interface):

![Dialog box for setting U923.i001](image)

Figure 4-57 Dialog box for setting U923.i001

- Carefully read the contents of the message box with the setting information for the application-dependent parameter P171 (position resolution) and acknowledge the message.

![Message box with setting information for P171](image)

Figure 4-58 Message box with setting information for P171
4.5 Connect MASTERDRIVES MC to the Technology-CPU

- Set the required value in the dialog box for the application-dependent parameter P171 (position resolution):

![Figure 4-59 Dialog box for setting P171](image1)

- Carefully read the contents of the message box with the setting information for the application-dependent parameter P183.i001 (position sensing configuration) and acknowledge the message.

![Figure 4-60 Message box with setting information for P183.i001](image2)

- Set the required value in the dialog box for the application-dependent parameter P183.i001 (position measurement configuration):

![Figure 4-61 Dialog box for setting P183.i001](image3)
4.5 Connect MASTERDRIVES MC to the Technology-CPU

- Carefully read the contents of the message box with the setting information for the application-dependent parameter P205 (rated velocity) and acknowledge the message.

![Message box with setting information for P205](image)

- Set the required value in the dialog box for the application-dependent parameter P205 (rated velocity):

![Dialog box for setting P205](image)

- Carefully read the contents of the message box with the setting information for the application-dependent parameter P770 (interpolator) and acknowledge the message.

![Message box with setting information for P770](image)
• Set the required value in the dialog box for the application-dependent parameter P770 (interpolator):

![Figure 4-65 Dialog box for setting P770](image)

• You have successfully commissioned the connection between Motion Control and the Technology CPU if, after running the script file, the following message is displayed "Completed" or "Complete".

![Figure 4-66 Message box, commissioning completed](image)

If an "Error" message also appears, then open the associated LOG FILE (it has the same name as the SCRIPT FILE but with the extension .LOG) either using the Log button or an editor. For Drive Monitor or Drive ES you will find the LOG FILE in the same directory as the script file.

**Note**

After configuration, the green 5 VDC LED and the yellow STOP LED light up on the Technology CPU (the mode switch is in the STOP position), and the 3 LEDs of the PROFIBUS module flash in synchronism on the MASTERDRIVES MC.
Commissioning

4.5 Connect MASTERDRIVES MC to the Technology-CPU
MASTERDRIVES MC commissioning tool

Introduction

This Chapter briefly explains how to establish a connection to the MASTERDRIVES MC via a serial interface using the DriveMonitor or DriveES commissioning tools.

The serial interface of the MASTERDRIVES MC is set to 9600 baud in the factory, and the bus address is set to 0. The bus address can be read-out using parameter P700 at the PMU operator panel at the drive converter (press key P until Pxxx or rxxx is displayed and then select parameter P700 using the arrow keys. The bus address is displayed by pressing the P key twice. The parameter number is re-displayed by pressing the P key again).

The baud rate is specified in parameter P701, whereby 6 means → 9600 baud, 7 → 19200 baud and 8 → 38400 baud (read-out the parameter the same as for P700).

Communication via DRIVE ES

Open the SIMATIC Manager and in the project directory insert a drive using Insert > Drive. In the following window, a MASTERDRIVES MC Plus is entered as drive type with device version 01.6 and bus address 0 (or the contents of parameter P700).

Then call-up the overview by clicking on the drive that was entered with the righthand mouse key and the menu Target system > Drive > Overview and then select Tools > Interface settings.

Under the Bus type tab, select USS and under the tab Interface, the COM interface used with 9600 baud (or the setting in P701). The windows are now closed and the connection to the drive is established using the menu Target systems > Drive > Parameterization (as described above).

Communication via Drive Monitor

Start Drive Monitor and set-up a parameter set using the menu File > New > Empty parameter set. In the following window, select the MASTERDRIVES MC drive with software version 01.6, the drive with bus address 0 (or the contents of P700) and click on OK.

The file is saved and the parameter set is opened offline. Establish the connection to the drive using the menu View > Online (EEPROM). If a connection cannot be established, you must set the interface via Tools > ONLINE settings (refer to the interface setting under DRIVE ES).